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Eagle GradeBook 3.0d
by

Rex Evans
840 Oak St.

Brentwood, CA 94513
rexevans@aol.com

( Yes, it’s FREE.)

Only Available on the Macintosh

Copyright

Copyright © 1992,1993,1994,1995 Rex Evans. This manual and the software described 
in it are copyrighted with all rights reserved. I used THINK Pascal™ to write this 
program, so portions of this program are ©1991 Symantic Corporation.

Limited Warranty on Media and Manual
Rex Evans makes no warranty, either explicit nor implied, with respect to this 

software, its quality, performance, or fitness for a particular purpose. Permission to use, 
copy, and distribute this software and its documentation for any purpose and without fee 
is hereby granted, provided that the above copyright notice and this permission notice 
appear in supporting documentation. This software is provided “as is” without express or 
implied warranty.

Introduction

Eagle GradeBook is written for school teachers to track a class of students. The 
basic functions of the program are to record attendance, record assignments and grades, 
compute student grades, and produce reports. A spreadsheet is used as the primary 
method of entering and maintaining data. The objective was to make the spreadsheet look 
much like the ones used in typical gradebooks. I have attempted to make the interface as 
friendly as possible and hope it is intuitive.

Each class may have any number of students and subjects. Within each subject 
there must be at least 1 category. Categories provide the following functions:

• Allows the teacher to group assignments (examples: homework, quiz, etc.).

• Each category may use a different grading method (points, letter grade, pass/fail, 
check marks [+, •, or -], or custom letter grades).
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• Weights assigned to categories may be used to compute the subject grade.

Each subject may have any number of assignments but each assignment must 
belong to a specific category. The category determines the form of grading to be used for 
the assignment.

Weights may be given for assignments and categories. Weights are only used with 
the 'Weighted Average' method of computing grades. There are two ways to apply the 
weights. One method uses the assignment weights to compute the category grades and 
then the category weights are used to compute the subject grade. With this option the 
assignment weights are relative only to 
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the category they belong to. The second way calculates the subject grade directly 
from all assignments. With this option the assignment weights are relative to the subject.

Planning Ahead

Although I believe the program is easy to use, you should put some thought into 
how you want to use it. In particular, think about how you plan to use categories and what 
form of grading is appropriate for each category. The only thing you cannot do later is 
change the form of grading. This is because I don't know what to do with the assignments 
already recorded in the category.

One consideration is the order in which you add subjects to the class. The order 
they are defined is the order used when multiple subjects are printed on a report.

You are allowed at any time to change the student's assignment grade, the weight 
of the assignment, the weight of the category, the point value of an assignment, the name 
of the assignment, the name of the category, the student's name, delete an assignment, etc.

If this is your first time using the Eagle GradeBook program I suggest you create a 
dummy class and play with it.

Requirements

• Any Macintosh (I targeted the Macintosh LC).

• System 6.05 or later.

• Hard disk recommended.

• 2 megabytes of memory for system 6, 4 megabytes for system 7. The code uses 
approximately 512K of memory.

Icons

This is the icon used for the Eagle GradeBook program. Double-click on this 

icon to start the program. You will be prompted to select a gradebook file to 
open or to create a new gradebook.

A gradebook file is created for each class. The file contains everything there is 

to know about the class.



Page 8

Creating Your First Grade Book

• Create a back-up copy of the Eagle GradeBook program!

• Double-click on the Eagle GradeBook icon. You will be asked to enter the name of 
your school and its phone number.

The school name and phone number will be embedded in the program and 
will appear on all reports. It may be edited later if necessary.
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• A file dialog will be displayed. Click on the 'New' button.

• Personalize the gradebook by entering the teacher, class, and room. This 
information will appear on reports and is carried with the gradebook (data file).

• Select the form of date to be used (mm/dd/yy, dd/mm/yy or yy-mm-dd). Once the 
gradebook is created the date format cannot be changed.

The following dialogs will be presented. Canceling a dialog allows you to enter the 
data at a later time by making the appropriate selection from the menus.

• The assumption is that you would probably want to enter the student names next, 
so a dialog is presented. You must provide at least a first and last name. The 
student ID, birthday, and phone are optional. As each student name is entered, the 
dialog will display the number of the next student to enter. If you wish, you could 
click on the 'Done' button and enter names at a later time.

Note: If you add a student at a later time, all existing assignments in the gradebook 
will be flagged as excused. You can change the entries later if you wish.

• All classes have at least one subject, so you will be prompted to enter one new 
subject name.

• At this time the spreadsheet for the subject will be displayed. Since assignments 
cannot be entered without at least one category defined, you will be prompted to 
define one at this time.

◊ Give a name to the category. It may be up to 32 characters wide.

◊ Click on the type of grading to be used for this category. All assignments in 
this category must use the selected grading.

◊ Determine what portion the subject grade the category represents by entering 
a weight. All category weights will be normalized when the grades are 
computed. To treat all categories with equal weighting, use the same value 
for each category. See the section on ‘Applying Weights’ for a full 
explanation.

◊ Click on the 'OK' button and the category will be added to the gradebook.

• Create your first assignment by selecting 'New Assignment' from the 'Assignment' 
menu.

◊ Describe the assignment. It may be up to 32 characters wide.
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◊ Click on one of the categories. This associates the assignment to the 
category and determines the type of grading for the assignment.

◊ If the category uses point grading, then enter the point value of the 
assignment. Otherwise, this field is ignored.

◊ Enter the weight the assignment will have on the category grade.

◊ The current date is provided. Change it to reflect when the assignment was 
given or due.
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◊ Click on the 'ADD' button. The assignment will be added to the gradebook 
and a new column will be inserted into the spreadsheet for the subject. Note 
that the column is added next to the student name column. This reverse 
ordering of assignments is to make it easy to enter the student grades. When 
reports are produced, or when the spreadsheet is printed, the columns will be 
in ascending order of assignments.

• Enter the student grades. Note that the first cell next to the first student name is 
highlighted. Just enter the grade and press the return key. The program will move 
to the cell for the next student. At any time you may return to any cell in the 
spreadsheet by clicking on it. Whenever a cell in an assignment column is 
highlighted, the name of the student and the date, description, and type of 
assignment are displayed in bold text above the columns.

• Your gradebook is now ready, but it has not been saved to disk. You may do so 
now or at any time. For this exercise, we will go ahead and create it. So, select 
'Save' from the 'File' menu. A dialog window will be displayed to allow you to 
name your gradebook file. Give it a name and click on the 'Save' button.

You have created your first gradebook and entered your first assignment. If this is 
an experimental gradebook you may wish to try the various selections in the menu to see 
what they do. When you are done, select 'Close' or 'Quit' from the 'File' menu. If you have 
made any changes since the gradebook was last saved, you will be asked if you wish to 
save the changes. If you click on 'Yes' the changes will be saved and the gradebook 
closed. If you click on 'No' the changes will be discarded and the gradebook closed. If 
you click on 'Cancel' the program will cancel the 'Save' or 'Quit' and you may resume 
making changes.

Using the Spreadsheet

A spreadsheet is used as the main window for viewing and editing student grades 
or attendance. The spreadsheet is made up of the following parts:

Title Bar The name of the current subject is always displayed in the 
window’s title bar. When you select a different subject, the title 
bar is updated along with all information in the spreadsheet.

General Info The window will always display the teacher, class, room, and 
subject. Additionally, when one of the grade cells is selected, 
the student’s name and assignment information is displayed in 
bold.
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Column Headings A heading is placed above each column. Since assignment 
descriptions are too wide to place above a column, the 
assignment’s number (given in the order they are created) is 
used. An assignment key report is available for cross 
referencing. For a quick reference, select any cell in the column 
and the assignment’s information will be displayed in the 
General Info area.

Name Cells Student names may be edited by clicking on the cell to be 
changed. The change takes effect when you press the return key 
or when you click anywhere outside of the cell. The student’s 
last name must be given first, followed by a comma, followed 
by the first name.

Grade Cells A grade may be entered or changed by clicking on the cell and 
entering the new information. When you select a cell, the name 
of the student and information about the assignment will be 
displayed 
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in the General Info area. The assignment information includes the assignment date, 
description, and the grading method to be used (points, letter, 
pass/fail, or check mark). If points grading is used then the 
maximum point value of the assignment is given. The change 
takes effect when you press the return key or click anywhere 
outside of the cell. If the return key is pressed, the next cell in 
the column will be selected unless it is the last cell.

Scroll Bars When there are more students than can be displayed in the 
spreadsheet, the vertical scroll bar becomes active. Likewise, as 
the number of assignments grows, the horizontal scroll bar 
becomes active. Note that the student name column is always 
visible. The horizontal scroll bar will only scroll the 
assignments section of the spreadsheet.

No   checking is done to insure that a student’s name is not entered more than once   
in the spreadsheet. As for grades, they must conform to the method selected for the 
assignment or the program will not accept the entry. When a grade is not accepted, the 
program will inform you and then change the cell back to its previous contents. You can 
then try again.

Notice that the assignments are given in reverse order in the spreadsheet. This was 
done to place new assignments next to the student names for easy reference. When the 
spreadsheet is printed the assignments will be given in ascending order. By the way, 
before you print the spreadsheet you may want to select ‘Page Setup’ from the ‘File’ 
menu and change the page layout to be landscape instead of portrait. I think it looks 
better that way. But it’s up to you. As many pages as are necessary will be printed to 
show all students and all assignments. You should also print the assignment key by 
selecting 'Print Assignments' from the 'Assignments' menu.

You can navigate through the spreadsheet by:
◊ clicking on cells,
◊ pressing the return key to advance down a column,
◊ using the scroll bars, or
◊ using the arrow keys.

The arrow keys only work after you have selected a cell with the mouse. If the cell 
is a student’s name, then only the up and down arrow keys may be used. If the cell is in 
an assignment column, then all four arrow keys may be used. In all cases, when along 
one of the borders of the spreadsheet the arrow key will scroll the spread sheet by one 
column or row. (Notice how the student name and assignment information in the General 
Info area changes as you move among the cells!)
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Entering Grades

To enter a grade for a student, find the row containing the student’s name  and then 
locate the column for the assignment. Then select the cell by clicking on it. The 
cell will become highlighted. You may then enter the grade. What will be accepted 
by the Eagle GradeBook program is determined by the grading method used for the 
assignment (see the section on ‘Grading Methods’ for details). If the data entered is 
not acceptable, the program will inform you and the cell will revert to its previous 
state. In addition to the grading information allowed by the grading method, the 
following data may be entered for all methods:
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<empty> An empty cell indicates a missed mark. Missed marks are given 
a score representing 45% (default) of the assignment’s worth 
when computing grades. (See 'Percentages' on the 'Edit' menu.)

ABS Absent. All absences must be resolved before a grade can be 
computed for the student.

X Excused assignment; not used in the calculation of the student’s 
grade.

The program will accept either all upper or all lower case letters.

Teachers have also asked for a way to attach some special meaning to a grade. 
Therefore, you may surround a grade with ‘()’, ‘{}’, or ‘<>‘. For example: ‘(C-)’, 
‘(P)’, ‘{73}’, ‘<•>‘. The significance of the notation is left to the teacher.

It is also possible to enter a grade but treat it as an excused assignment (not used in 
the calculation of the grade). This may be done by surrounding the grade with 
brackets ('[' and ']'). For example: '[79.3]', '[C-]'.

To enter a bullet (•) for a check mark grade, hold down the ‘option’ key and press 
the ‘8’ key. The bullet was selected since it is available on all fonts.

Entering Attendance

Manipulation of the attendance spreadsheet is identical to the subject spreadsheet. 
The attendance spreadsheet differs in that all columns for the entire term are 
predefined. By default a blank cell indicates the student was present. Only 
characters defined with the attendance key dialog will be accepted.

Grading Methods

The Eagle GradeBook program supports four predefined forms of grading and 
allows you to define a fifth, custom letter grades. You may use any combination of 
grading within each subject. However, you can only use one form of grading within a 
category. The available forms are:

Points A numerical value is given to each assignment. The value represents 
the maximum number of points available for the assignment. When 
computing grades, categories with point grades will use actual values 
assigned.

Letter Letter grades:  ‘A+’,  ‘A’,  ‘A-’,  ‘B+’,  ‘B’,  ‘B-’,  ‘C+’,  ‘C’,  ‘C-’,  
‘D+’,  ‘D’,  ‘D-’, and ‘F’. When computing grades, categories with 
letter grades will map the grades to the following values (scaled to 
100):
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A+ = 101 C+ = 78 F = 50
A = 96.5 C = 74
A- = 91 C- = 70.5
B+ = 88 D+ = 66.5
B = 84.5 D = 61
B- = 81 D- = 54.5

Total value for each letter assignment will be 12.

Pass/Fail A pass/fail or credit/no credit is represented by ‘P’ & ‘F’ or ‘C’ & ‘N’. 
When calculating grades, a pass has a value of 1.0 and a fail has a 
value of 0.5 and the assignment has a value of 1.
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Check Mark The symbols -, •, and + are used. The marks will map to
‘-’=0.61(D), ‘•’=0.74(C), and ‘+’=0.95(A) with a total value of 1.0 for 
each assignment. (Note: The ‘•’ is entered by holding down the 
‘option’ key and pressing the ‘8’ key.)

Custom You may define your own letter grades to be used by selecting 
'Custom Grades' from the 'Edit' menu. Once defined, the custom grade 
method may be selected for a category. Custom grades must also 
supply the grade-to-percentage and percentage-to-grade mappings to 
be used when computing grades.

The percentage mappings shown above may be changed selecting the 'Percentages' 
option from the 'Edit' menu.

Applying Weights

The first thing to remember when defining weights is that they will be normalized 
when computing grades. For example, if only three weights were provided and they have 
a value of 5, 5, and 10, respectively, then the first two would each represent 25% of the 
grade and the third would represent 50% of the grade. 

Weights only apply when the "Weighted Average" method is selected when grades 
are computed.

Assignment weights may be used to compute category grades or to compute the 
subject grade directly, depending on which compute method you choose. However, it 
important to know which method you will use since the weights you assign would 
probably be different.

Category weights are only used when the subject grade is to be computed from the 
category grades. When the subject grades is computed directly from the assignments then 
category weights are not used.

When the Weighted Average method is not used to compute grades then weights 
are not used. An exception is when a negative weight is used to indicate extra credit 
assignments and when zero weights are used to indicate assignments or categories that 
are not to be used when computing grades.

A zero weight for an assignment is used for assignments that will not be used in 
calculating the grade (see ‘No Credit’). Also, a zero weight for a category will exclude 
the category, and all assignments in the category, from the calculation of the subject 
grade.
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A negative weight for an assignment is used for extra credit assignments. The 
weight is made positive and then used to determine the effect it will have on the category 
grade (see ‘Extra Credit’).

Extra Credit

Extra credit assignments are identified by assigning them a negative weight. The 
weight should be given as a fraction of the grade. For example, if an assignment can raise 
the grade by at most 2%, then enter the weight as ‘-0.02’. 

For example, assume a score of 45 out of 50 was given for an extra credit 
assignment with a weight of -0.02 and assume the category grade was computed to be 
83%. Then the final category grade would be:
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83% + 100% * 0.02 * (45 / 50) = 84.8%

Extra credit assignments are accumulative. The method of computing grades only 
applies to the calculation of the grade before adding extra credit assignments.

No Credit

If you do not wish for an assignment to contribute to the calculation of a grade, 
then give it a weight of zero (0.0). Zero weight assignments will be skipped when 
computing the grades.

In the same way, a category can be skipped when computing the subject grade by 
giving the category a weight of zero.

Computing Grades

The Eagle GradeBook provides a straight average, even average, and weighted 
average way to compute grades. Additionally, the subject grade may be computed from 
the category grades or from all assignments. (Category grades are always computed using 
the assignments within the category). This gives six combinations available to choose 
from when grades are to be computed.

When the Eagle GradeBook program is asked to compute grades, it will ask you to 
select the method to use. First you must choose the straight, even, or weighted method 
and second you must choose that the subject grade be computed from categories or from 
assignments.

It is very important to realize that when the subject grade is to be computed from 
the category grades the assignment grades are used to calculate category grades and then 
category grades (not assignments) are used to compute the subject grade. When the 
subject grades is computed from all assignments the category grades are computed but 
not used.

Percentages are used internally by the Eagle GradeBook program when computing 
grades. The assignment grade is first converted to a percentage (the ratio of the number 
correct divided by the possible score then multiplied by 100). Then the method of 
computing the category and then the subject grade are applied.

The formulas used when copmuting grades are as follows:

Let: M = Assignment mark (grade)
W = Assignment weight
V = Assignment total value
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N = Number of assignments
P = Percent of maximum grade for assignment

Straight Average: P =100×
M∑
V∑

Even Average: P =100×
M
V

×
1
N∑

Weighted Average: P =100×
M
V

×
W
W∑

 ⎛

 ⎝ ⎜
 ⎞

 ⎠
 ⎟∑



Page 21

Excused assignments are not included in the calculation of grades. Missed 
assignments are given a value equal to 45% of the assignment’s worth. (This may be 
changed using the 'Percentages' option from the 'Edit' menu.)

Extra credit assignments are computed and added after the percentage is computed. 
The weight should be given as a fraction of the grade. For example, if an assignment can 
raise the grade by at most 2%, then enter the weight as ‘-0.02’. Each extra credit 
assignment is added as follows:

Extra Credit: P =P+
M
V

× W ×100

After the percentage grades are computed, they are mapped to letter grades as 
follows:

> 100 A+ 77 : 79 C+
93 : 100 A 72 : 76 C
90 : 92 A- 70 : 71 C-
87 : 89 B+ 64 : 69 D+
83 : 86 B 59 : 63 D
80 : 82 B- 51 : 58 D-

0 : 50 F

The values used when mapping between percentages and grades may be changed 
by selecting 'Percentages' from the 'Edit' menu.

Making Changes

Almost any entered information may be changed at any time.  The only thing you 
cannot do later is change the form of grading. This is because I don't know what to do 
with the assignments already recorded in the category.

You are allowed at any time to change the student's assignment grade, the weight 
of the assignment, the weight of the category, the point value of an assignment, the name 
of the assignment, the name of the category, the student's name, delete an assignment, etc.

To change any cell in a spreadsheet, simply click on the cell to highlight it. Then 
enter the new data and press the return key. If the new data is not allowed (like in a wrong 
grade type for the assignment) the GradeBook program will inform you and the cell will 
revert to its last value.
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Menu Choices

Apple Menu

About GradeBook

A credits dialog is displayed.

File Menu

New

Create a new gradebook. A file for the gradebook is not created until you select 
‘Close’, ‘Save’, ‘Save As...’, or ‘Quit’.
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Open

Open an existing gradebook and display the spreadsheet for the first subject.

Close

Close the current gradebook. If any changes have been made, you will be asked if 
you wish to save them.

Save

Save all changes to the current gradebook to the disk file. If no file has yet been 
created, then you will be asked to name a new file for the gradebook.

Save As...

The current gradebook may be saved to disk under a new file name. All subsequent 
changes will be saved to the new file.

Page Setup...

Set the printing style for your printer (paper type, page orientation, etc.).  Selected 
options are used for all subsequent printing.

Print

A sub-menu provides a selection of all available reports. Available reports are:
◊ Assignments Also available from the ‘Assignments’ menu.
◊ Attendance Chart Also available from the 'Attendance' menu.
◊ Blank Spreadsheet
◊ Class Average Also available from the ‘Assignments’ menu.
◊ Class Statistics Also available from the 'Subject' menu.
◊ Comment Page Also available from the 'Student' menu.
◊ Cover Page
◊ Missed Marks Also available from the ‘Assignments’ menu.
◊ Missed Work Also available from the ‘Student’ menu.
◊ Progress Report Also available from the ‘Student’ menu.
◊ Recent Assignments Also available from the ‘Assignments’ menu.
◊ Report Marks Also available from the 'Assignments' menu.
◊ Spreadsheet
◊ Student Grades Also available from the ‘Student’ menu.
◊ Student Listing
◊ Student Report Also available from the ‘Student’ menu.
◊ Subject Report Also available from the 'Subject' menu.
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See the ‘Available Reports’ section for a description of each report.

Import Students...

Students may be added to the current gradebook by importing them from a text 
file. Each line of the text file represents one student and must contain the student's 
ID, first name, last name, birthday, and phone separated by the tab character: 

ID<tab>first<tab>last<tab>bday<tab>phone



Page 25

The student ID, birthday, and phone are all opotional, but all tabs are required, 
even if a field is blank. No test is performed to see if a student is already in the 
gradebook.

Merge...

This command is only available when no gradebook is open. The objective is to 
search a folder of gradebook files and extract information about a student. Each 
gradebook can only contain one subject. The extracted information is used to 
create a new gradebook that contains only the one student and grade information 
from each subject.

To use the Merge command, all gradebook files to be searched must be in one 
folder. A separate folder shoud be created to receive the merged gradebook file. 
Student IDs must be used in all gradebooks.

A dialog is presented in which you can enter the student ID or the name of a text 
file that contains one student ID per line. (The ID may be folllowed by a tab 
character and any additional information you wish. Only the ID is used for the 
merge.) Two additional dialogs are then presented, one for selecting the folder to 
be searched and the other for selecting the folder in which merged gradebook files 
are to be stored. Do not use the same folder!!

If all goes well, the program will scan files, extract data, and create a file for each 
student ID. I give a 90% confidence in this command. It works, but I don't feel real 
confident that all bugs have been found. If you encounter problems, drop me a line 
and give me as much detail as possible and I will try and fix it.

Plot...

This command prints a line plot of student grades. In the presented dialog indicate 
if you wish a line plot of a subject, category, or assignment. Also select the method 
of computing grades (straight, even, weighted) and how grades are to be 
represented (points, letter, etc.). You may also indicate if you want horizontal lines 
drawn for the median, mean, and standard deviation.

The x-axis represents the students with non-zero grades, sorted in ascending order. 
The y-axis is percentage. Along side of the y-axis the grade ranges are shown. For 
point grades, the point value is given at each 5% interval. For other grading 
methods a horizontal line is drawn at the lower percentage level of the grade. The 
result is a percentage range that will yield the grade. The grade for each range is 
shown along the y-axis.
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If the median, mean, or standard deviation is requested, a horizontal line is drawn 
at the appropriate percentage value.

Load...

The text file produced by the 'Unload...' command may be used to create a new 
gradebook with the 'Load...' command. The format of the file is significant and any 
changes may result in this command failing. This command was added primarily 
for code debugging.

Unload...

This command will dump the entire contents of a gradebook to a text file. The text 
file may then be opened, edited, printed, or whatever with any utility that accepts a 
text file. Note that student grades are output with five grades per line, tab 
delimited.
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Help

A on-line help package is brought up. Make a selection for more information. Click 
on ‘Cancel’ to dismiss the help package.

Quit

If a gradebook is open and has been modified, you will be asked if you wish to 
save it to disk before quitting. ‘Yes’ will save the changes while ‘No’ will discard 
the changes before quitting.

Edit Menu

Attendance Key

Keeping attendance is optional. When a new gradebook is created you will be 
prompted with the attendance key dialog. If you cancel you can still activate 
attendance recording by selecting the 'Attendance Key' option from the 'Edit' 
menu.

When you first activate the attendance recording you must supply the date of the 
first day of the school term and which days of the week school is in session. Once 
the dates are defined they cannot be changed later.

Attendance is recorded using a single character. By default (the cell is empty) the 
student is present. Up to 8 attendance characters may be defined. Some character s 
may represent absence while others may represent whatever you want. At least one 
character must represent absence. To indicate a character represents absence, click 
the check-box to the left of the character. Attendance keys may be changed later.

Check-List

A check-list is printed on every Progress Report. The check-list can contain up to 
ten lines. Selecting 'Check-List' from this menu allows you to edit the check-list. 
The new list will be used on all subsequent Progress Reports.

Clear GradeBook

The Eagle GradeBook program was designed to support only one school term. At 
the end of a term the gradebook file should be copied and saved for future 
reference. A dialog window is presented to allow you to select what is to be cleared 
from the gradebook.
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Column Widths

With this command you may make the width of the name and/or grade columns of 
displayed and printed spreadsheets bigger or smaller.

Custom Grades

In addition to the four predefined grading methods (percentage, letter grades, 
pass/fail, and plus, check, minus) you may define custom letter grades. For 
example, you may want "A B C D E F", or "O E S M U", etc. Once custom grades 
are defined you may select it when defining the grading method of a category.
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The custom grades may contain up to 13 symbols. They must be defined from high 
to low. You must also provide a grade-to-percentage and a percentage-to-grade 
mapping. The grade-to-percentage mapping is used when the letter grade is 
converted to a percentage. The percentage-to-letter mapping represents the lowest 
percentage of the grade's range. The upper limit of the range is less than the lowest 
percentage for the next higher grade.

Fit Chart to Screen

Sometimes when a gradebook is moved between Macintosh systems the 
spreadsheets may be too big. Selecting this option will change the size, not the 
position, of the spreadsheet to a size that will fit the current screen (less some 
space on the right). You may need to move the spreadsheet position if portions are 
still outside of the screen.

Font

The font type and size used in the top spreadsheet window may be changed with 
this command. The new font selection will be remembered.

Password

Two independent passwords are supported. The file password, if set, will be 
required to open a gradebook file. The configuration password, if set, will be 
required to make changes to selected user definable settings. Each gradebook may 
have it's own passwords.

If a password is already defined you must enter the current password before you 
may change it. A empty password field means no password is required.

When setting the configuration password you must select what configuration 
settings it applies to. Then when an attempt is made to change protected settings 
the password will be requested. The configuration password may apply to any or 
all of the following:

Attendance Key
Categories and their weights
Check-List
Custom Grades
Grade <--> Percentage mappings

Do not forget your passwords. There is no hidden way to clear the passwords.
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Percentages

The default mappings from grades to percentages and from percentages to grades 
(see 'Grading Methods') may be changed by selecting this option from the Edit 
menu.

The grade to percentage mapping is used when marks are evaluated for computing 
a grade. Each grade maps to a specific percentage value.

The percentage to grade mapping is used when the computed percentage is 
converted back to a grade. All percentages within a range map to the same grade.

It is suggested that you change both mappings at the same time.
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School Name

When the Eagle GradeBook program is first executed, it asks for the name of the 
school and the school’s phone number. This name and number becomes embedded 
within the program.  All gradebooks will use this name when producing reports. 
This command allows you to change the school name and phone number. The new 
name and number will replace the old ones within the program.

Subject Name

This option allows you to edit the name of a subject. No other information within 
the subject is modified.

Teacher, Grade, Room

This option allows you to edit the teacher, grade, and room information.

Student Menu

New Student

A first and last name must be given for the student. The student ID is optional 
(social security number is OK). The birthday and phone number are also optional. 
Pressing the return key or clicking on the ‘Enter’ button will add the student to the 
gradebook. New names are added after all existing students. All existing 
assignments will be marked as excused for the new student. You may change the 
assignment entries later. Click on the ‘Done’ button to dismiss the new student 
dialog window.

Delete Student

A student can be deleted from the gradebook. When this option is selected a 
warning dialog is displayed and you must acknowledge that you truly want to 
delete the student.

It is suggested that you save a copy of the gradebook before deleting a student.

Edit Student

This allows you to edit the student name, ID, birthday, and phone.

Sort Names

The ‘Sort Names’ option will sort all student records in all subjects. The names 
may be sorted by first name, last name, or student ID. For more than one student 
with the same last name you may wish to sort by first name and then sort again by 
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last name.

Comment Page

The 'Comment Page' option will produce a standard template page for comments 
for one or all students. The title of the page is supplied by the user. From one to 
five box titles may be given. For each box title given the title is output, a empty 
box is drawn for hand written comments, and a optional signature line is provided. 
If 'blank' is given for a box title then no title will be placed above the box.
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Missed Work

The ‘Missed Work’ option will produce a report of all missed assignments or 
missed assignments on or after a specified date. The report can be given by student 
or subject. When it is given by student and all students are selected then each 
student will start a new page. When it is given by subject and all subjects are 
selected then each subject will start a new page. The style of the report varies with 
the options selected from the dialog window. Under certain combinations of 
options the report can only go to the printer. Otherwise the report may be displayed 
or printed. If displayed, you can then click on a ‘Print’ button to print the report. 
See 'Available Reports' below for more detail on the 'Missed Work' report.

Progress Report

This report is intended to be sent home each grading period. The report gives the 
student’s current grade in each subject.

If the ‘All Students’ option is not selected then a dialog will be presented for you to 
select the student.

You must select a grading period and grading method. The selected grading period 
is added to the report. The current date is provided. Change the date if necessary. 
The date will be added to the report.

A check-list is printed on all Progress Reports. The list, which can contain up to ten 
lines, may be edited by selecting 'Check-List' from the Edit menu. The edited list is 
remembered and will be used for all subsequent reports.

An option is available for having the statement 'Number of days Absent:___' added 
to the report.

Options permit any combination of the parent, student, and teacher signatures to be 
required on the report. If the parent and student signatures are not required, the 
request for signature and return to school sentence and the comments sentence are 
not output.

Student Grades

Compute a report showing the current grade in each subject for every student. All 
absences and missed marks must be resolved before this report will be produced. 
The report may be given using the student name or the student ID. The report is 
displayed on the monitor and may be forwarded to the printer.
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Student Report

Display and/or print student reports. By default, all subjects, categories, and 
assignments will be listed in the report. Grades will be computed and output with 
the report unless there are outstanding absences.

If the ‘All Students’ box is checked then the reports will only go to the printer due 
to the volume of output. When printed, each student report starts on a new page. If 
the ‘All Students’ box is not checked, you will be asked to select the student.

If the ‘All Subjects’ box is not checked, then you will be asked which subject to 
report.
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If the ‘List Categories’ box is checked, then all categories will be output with 
category grades.

If the ‘List Assignments’ box is checked then all assignments will be output with 
the student’s grade. If the ‘List Categories’ box is checked, then the assignments 
will be grouped with the category. Otherwise, they will be listed in the order they 
were given.

You must select which method is to be used to compute grades. See the section on 
‘Computing Grades’ for a description of each method. When the ‘Weighted 
Average’ method is selected, normalized weights will be added to the report.

You must select the form of reporting the grades. The 'As Marked' option will use 
the grade as entered in the spreadsheet for the assignment but will use letter grades 
for the category and subject. The 'Points' option will use the point grade as entered 
or will use a computed percentage if the assignment grade was other than a point 
value. The computed category and subject grades will be output as percentage. The 
'Letter', 'Pass/Fail', and '+ • -' options will convert all grades to a percentage and 
then to the selected form for output.

The 'Assignment Date', 'Class Low, High, Average', 'Percentage', and 'Weight' 
options produce additional columns of output on the report. You may select any 
combination of the three. Note that the 'Class Low, High, Average' option takes 
time to compute. The good news is the code remembers when the calculation was 
done and will only recompute the data when necessary (like when you change a 
grade or select a different method for computing the grades).

When ‘to Monitor’ is selected, the student’s report will be displayed. A ‘Print’ 
button is added to the report’s window so you can print the report after viewing it.

Subject Menu

New Subject

A new subject may be added at any time. When a new subject is created, a 
spreadsheet is created and then the ‘New Category’ dialog is displayed (see 
‘Category’ menu). At least one category must be defined for each subject. Define it 
now or click on the ‘Cancel’ button if you want to define it later.

Compute Grades

Selecting ‘Compute Grades’ will calculate each student’s grades for all categories 
and for the subject. The grades are then inserted into the spreadsheet. For example, 
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if there are 15 assignments in 3 categories, then columns 16, 17, and 18 will 
contain the category grades and column 19 will contain the subject grade.

‘Compute Grades’ only applies to the subject currently displayed in the 
spreadsheet. All absences must be removed before computing grades. Otherwise 
the command will cancel.

Any change to the status of the subject for which grades have been computed will 
result in the computed grades being removed from the spreadsheet. Obviously, 
changes void the current calculations.
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Using ‘Compute Grades’ is completely independent from the ‘Student Report’ 
option in the ‘Student’ menu. In other words, you do not need to use ‘Compute 
Grades’ before using the ‘Student Report’, or visa versa.

Select the desired method for computing grades.  Then select how the grade is to 
be entered into the spreadsheet. See the ‘Computing Grades’ section above for a 
description of each method.

Delete Computed

Selecting 'Delete Computed' will remove the category and subject grades that were 
added to the spreadsheet when 'Compute Grades' was selected. (See above.)

Delete Subject

A subject can be deleted from the gradebook. However, deleting a subject will also 
delete all assignments within the subject. When this option is selected a warning 
dialog is displayed and you must acknowledge that you truly want to delete the 
subject.

It is recommended that you back up the gradebook before deleting any subjects.

Class Statistics

The statistics for the current subject are computed and a report is generated. The 
report gives the low, high, mean, median, and standard deviation (in percentage) 
for the subject, each category, and each assignment.

Subject Report

For a selected subject and student a report is generated giving the subject and 
category grades earned. A category with a zero weight will be printed but will not 
participate in the calculation of the subject grade. You may also change the report 
name, which is printed at the top of the page.

Options permit any combination of the parent, student, and teacher signatures to be 
required on the report. If the parent and student signatures are not required, the 
request for signature and return to school sentence and the comments sentence are 
not output.

<subject name>

As each subject is created, it’s name is added to the ‘Subject’ menu. Selecting one 
of the subject names will bring that subject into the spreadsheet, update the 
‘Category’ menu, and make all assignments available for editing.
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Category Menu

New Category

A category is used to determine the grading method to be used for assignments. At 
least one category must be defined for each subject. Each category can use only 
one grading method.
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The category also has a weight associated with it. A category grade is calculated 
from all assignments within the category. The weight may then be applied to the 
category grade when calculating the grade for the subject(optional). See the section 
on ‘Applying Weights’ for details. The category weights will be normalized before 
calculating the subject grade.

Give a name to the category. Then select the grading method to be used for 
assignments within the category. See the section on ‘Grading Methods’ above for 
details. Finally, give the weight this category will have on the final subject grade. 
(Note, using the same weight for all categories (1 is nice) will treat all categories 
equally when calculating the subject grade.)

The category’s name and weight may be changed at any time. However, the 
grading method cannot be changed. (What would I do with the assignments in the 
category!)

Delete Category

A category can be deleted from the gradebook. However, deleting a category will 
also delete all assignments within the category. When this option is selected a 
warning dialog is displayed and you must acknowledge that you truly want to 
delete the category.

<category name>

As each category is created, it’s name is added to the ‘Category’ menu. Selecting 
one of the category names will bring up a dialog window that will allow you to 
change the name or weight of the category. The category’s grading method cannot 
be changed.

Assignment Menu

New Assignment

The ‘New Assignment’ option allows you to add an assignment to the current 
subject.

The assignment description may be up to 32 characters. A category must be 
selected since it determines the method of grading to be used. If point grades 
(scores) are to be used, then enter the maximum point value of the assignment. 
Otherwise, the points field is ignored. The current date may be accepted or 
changed.

Each assignment is also given a weight. The weight is used to determine the 
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portion the assignment is of the grade. Suppose you give three assignments and 
decide that the first will count 30% of the grade; the second 30% of the grade; and 
the final 40% of the grade. Suppose that point grading is used and the point value 
of the first test is 100, the second is also 100, and the third is 150. When you add 
the assignments, enter weights of 30, 30, and 40 (or 3, 3, and 4; or 6, 6, and 8; etc. 
The weights will be normalized to 100%). If Rex scores grades of 80/100, 60/100, 
and 120/150, then Rex’s grades are computed as the raw averages of 80%, 60%, 
and 80%; and the weighting of the assignments will produce a grade of:

(80%*30%) + (60%*30%) + (80%*40%) = 74% (C)

The weights are only used when computing grades using the ‘Weighted Average’ 
method. See the section on ‘Grading Methods’ above.
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Assignments may also be given a negative weight. Such assignments are treated as 
extra credit. Care should be given to selecting the weight since it is not averaged 
with the other weights. The weight should be given as a fraction of the grade. For 
example, if an assignment can raise the grade by at most 2%, then enter the weight 
as ‘-0.02’.

Once the assignment is defined, it will be added to the subject’s spreadsheet. 
Student grades may then be entered through the spreadsheet.

Edit Assignment

All information about an assignment may be changed except which category it is in 
and what grading method is used.

Delete Assignment

A list of all assignments will be presented in a scrollable window. Click on the 
name of the assignment to be deleted and then click on the ‘OK’ button.

A final confirmation dialog window will then be displayed. Click on the ‘Yes’ 
button and the assignment will be deleted from the spreadsheet and the gradebook.

Display in Reverse Order

While spreadsheets are always printed with the columns in ascending order, 
displayed spreadsheets may have the columns in ascending or descending order. 
This option is a switch which changes the order in which the columns are 
displayed. When the descending order is active this menu item will have a check 
mark next to it.

Fill Assignment...

This option will give all students the same grade for a specified assignment. First a 
list of all assignments in the subject is presented. After selecting the assignment, 
another dialog is presented for specifying the grade to be given.

Sort Assignments...

Assignments may be sorted by date or by category. Note that sorting first by date 
and then again by category will sort assignments by date within each category. The 
sort applies to the current subject (front subject spreadsheet).

Wrong Category...

To make it easier for the user when an assignment is accidently entered into the 
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wrong category, this command will allow the assignment to be moved to a different 
category. However, this is only allowed if there are no grades recorded for the 
assignment or the target category uses the same kind of grades as the assignment.

This command will display a short message explaining the conditions for moving 
the assignment. It will then ask for the assignment to be selected. Finally, it will 
ask for the target category to be selected.
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Class Average

This option will produce a report of class averages for the current subject. Averages 
will be given for the subject, categories, and assignments. The report is output to 
the monitor. A button is then available for printing the report. Only students that 
completed the assignment are used when computing the averages.

The average for subjects and categories are given in percentages. The average 
given for assignments is the average ‘point’ value of the assignment. Letter, 
pass/fail, and -,•,+ grades are converted to a point value for averaging. All grades 
are also reported as a letter grade.

Display Assignments

This option will display an assignment key for the current subject. The report gives 
the assignment’s column number, description, weight, grading method, point value 
(if appropriate), and category.

Missed Marks

The ‘Missed Marks’ option will produce one of two reports: all students that 
missed an assignment, or all assignments missed by a student. Based on the options 
selected in the dialog window, a list of assignments or students will be displayed. 
Make a selection and click on the ‘OK’ button. The report will be displayed in a 
window or printed. If displayed, you can then click on a ‘Print’ button to print the 
report.

Print Assignments

This option will print an assignment key for the current subject. The report gives 
the assignment’s column number, description, weight, grading method, point value 
(if appropriate), and category.

Recent Assignments

This option will display or print a report showing all assignments on or after a 
specified date. The assignments will be presented by category for all subjects.

Report Marks

This option will display or print a report showing the marks of all students given in 
a rank order from high to low for an assignment. A grade column gives the mark as 
entered. A percent column gives the mark as a percentage. Statistics for the 
assignment are computed and output. Absences, excused, and missed marks are not 
included in the statistics.
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Attendance Menu

Show Attendance

When attendance recording is active this option will display the attendance 
spreadsheet. Attendance is maintained by entries into this spreadsheet.
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Print Attendance

When attendance recording is active this option will print the attendance 
spreadsheet. You will be asked to enter the range of days you wish printed.

Print Summary

A report is generated showing, for each student, the number of occurances for each 
defined attendance key.

Clear Date...

This command will clear all entries in the attendance spreadsheet for a specified 
date.

Fill Date...

This command will fill all entries in the attendance spreadsheet for a specified date 
with a specified character.

Go To Date...

This command will bring a specified date into view in the attendance spreadsheet.

Available Reports

The following reports are currently available. Additional reports will be written 
once I know what is wanted.

Assignment Key For the selected subject the categories are listed with their 
assigned weights and kind of grades. All assignments are then 
listed giving their assigned weight, kind of grade (and 
maximum value if a point grade), and category. The 
assignments are numbered in the order they were entered and 
correspond to the column numbers on the spreadsheet (see 
below).

Attendance Chart The attendance chart will be printed for a specified range of 
dates.

Blank Spreadsheet A spreadsheet is printed in which only the student names or IDs 
are given. All other columns are blank.

Class Average For the current subject the average grade is computed for each 
assignment. Students who missed the assignment, were 
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excused, or were absent are not included in the average. The 
average grade for each category is then computed, excluding 
extra credit assignments and assignments with a zero weight. 
Finally, the average grade for the subject is computed. Both a 
weighted and non-weighted average is computed for the subject 
and categories. The report will list the averages for the subject, 
categories, and assignments.

Class Statistics This report is given for the current subject. You must select the 
method of computing grades (straight, even, weighted). Grades 
are then computed for each student. This is followed by a 
calculation of the low, high, mean, median, and standard 
deviation percentages for each assignment, category, and the 
subject. Missed, excused, and 
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absences are not included in the calculations. The report will list the statistics for 
the subject, categories, and assignments.

Comment Page This report will produce a standard template page for comments 
for one or all students. The title of the page is supplied by the 
user. From one to five box titles may be given. For each box 
title given the title is output, a empty box is drawn for hand 
written comments, and a optional signature line is provided. If 
'blank' is given for a box title then no title will be placed above 
the box.

Cover Page The Cover Page will contain the school name, student name, 
date of birth, year level, date of the report, and the names of the 
accademic subjects.

Missed Marks This report may be given by assignment or by student. If by 
assignment, you will be asked to select the assignment from the 
current subject. The report will contain the assignment number, 
name, value (weight), date, and category. A list of students who 
missed the assignment is then given.

If the report is by student, you will be asked to select the 
student. The report will contain the student's name followed by 
all missed assignments in the current subject. For each 
assignment, its number, name, value (weight), date, and 
category will be given.

Missed Work This report has a number of options which will determine the 
form of the report. The option that determines the overall style 
of the report is if it is given by student or by subject.

If by subject is selected then for each assignment in a subject a 
list of students that missed the assignment is given. This form is 
intended for use by the teacher.

If by student, then for each subject a list of missed assignments 
is given. This form is intended to be sent home.

In both report forms you are given the option to have all missed 
assignments listed or only assignments with given on or after a 
date you supply.

You are also given the option to have reports generated for all 
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students and/or all subjects. If all students is not selected, you 
will be asked to select a student. If all subjects is not selected, 
you will be asked to select a subject.

Some customization of the report 'by student' is available 
through a 'Options...' button  on the dialog. Changes are saved 
in the data file and stay in effect until changed again. Available 
options are:

◊ Include a due date for missed work. The due date must be 
supplied each time reports are generated.

◊ Include a place for the parent signature.
◊ Include a place for the student signature.
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◊ Include a reminder of the highest grade late work can 
receive and what grade is given for missed work. Both 
must be supplied when this option is selected.

Progress Report The progress report is intended to be sent home to the parents. 
A progress report will not be generated for a student with any 
assignments indicating the student was absent. Absences must 
be resolved by entering a grade, excusing the assignment, or 
leaving it blank (indicating a missed assignment).

You must select the method of computing the grades (straight, 
even, weighted) and the form in which the grades will be output 
(letter, pass/fail, +•-, or percentage). A date for the report is also 
required.

The grade earned to date is computed and given for each 
subject. Space is provided for additional written comments.

A standard check-list of areas the student needs work is also 
produced. Areas needing work are checked by you after the 
report is generated. This check-list may be customized by 
selecting 'Check-List' on the Edit menu before producing the 
reports.

Any combination of the parent, student, and teacher signatures 
may be required.

The report can be generated for one student, all students, or 
only students with a computed grade below a specified 
percentage in one or more subjects.

Recent Assignments This report gives a list of every assignment in every 
subject on or after a date supplied by you.  The list is ordered 
by subject and category. The name, grade given, and date is 
given for each assignment.

The report may be generated for one or all students. When the 
report is to be generated for only one student, you will be asked 
to select the student.

Report Marks The marks of all students are given in a rank order from high to 
low for an assignment. A grade column gives the mark as 
entered. A percent column gives the mark as a percentage. 
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Statistics for the assignment are computed and output. 
Absences, excused, and missed marks are not included in the 
statistics.

Spreadsheet A spreadsheet of the current subject is printed using as many 
pages as needed. The report differs from the displayed 
spreadsheet in that the assignments are in ascending order. 
Since there is insufficient space to give the assignment name 
above each column, the assignment number is used. To get the 
mapping from assignment number to assignment name, select 
'Print Assignments' from the Assignment menu for the 
Assignment Key report. The spreadsheet may be printed with 
either the student names or student IDs.
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Student Grades To produce a Student Grades report you will be asked to select 
the computation method (straight, even, weighted) and how the 
grades are to be shown (percentage, letter, pass/fail, or +•-). The 
report may be given using the student name or the student ID. 
The grade for each student is then calculated for all subjects.

Any outstanding absences (an assignment with 'AB' entered as 
the grade) will abort production of this report.

Assignments with a zero weight and excused assignments are 
not included in the calculations. Missed assignments are scored 
below an 'F' (default). Extra credit assignments are applied after 
a grade is computed.

After all grades are computed, the low, high, and average 
percentage for the class is computed for each subject.

The report begins with a subject key showing the number 
assigned to each subject, the subject names, and the low, high, 
and average percentages for each subject. Then each student's 
name or ID, followed by the calculated grade in each subject, is 
given. The report is displayed on the monitor and may be 
forwarded to the printer.

Student Listing This report lists the name, ID,birthday, and phone of each 
student. The report is displayed and then may be printed.

Student Report To produce a Student Report you will be asked to select the 
computation method (straight, even, weighted) and how the 
grades are to be shown (as marked, points, letter, pass/fail, or 
+•-). 

The amount of information provided on the Student Report is 
determined by the options you select.

All Students
If this option is not selected then the report will 
only be produced for one student and you will be 
asked to select the student.

All Subjects
If this option is not selected then information for 
only one subject will be included and you will be 
asked to select the subject.
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List Categories
If this option is selected then category information 
will be produced.

List Assignments
If this option is selected then information on each 
assignment is produced. If the List Categories 
option is also selected then the assignments will be 
grouped under the appropriate category. Otherwise 
they will be listed in the order they were entered 
into the gradebook.

A grade column is always produced. In addition the following 
information may be requested:
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Assignment Date
If this option is selected then the date of each 
assignment is output.

Class Low, High, Average
If this option is selected then statistics are 
computed and columns are produced with the low, 
high, and average percentages for the class.

Percentage
If this option is selected then a column is produced 
showing the grade as a percentage of the maximum 
possible grade.

Weight If this option is selected then a column is produced 
with the normalized weights of the assignments 
and categories.

Subject Report For a selected subject and student a report is generated giving 
the subject and category grades earned. A category with a zero 
weight will be printed but will not participate in the calculation 
of the subject grade. You may also change the report name, 
which is printed at the top of the page.

A standard check-list of areas the student needs work is also 
produced. Areas needing work are checked by you after the 
report is generated. This check-list may be customized by 
selecting 'Check-List' on the Edit menu before producing the 
reports.

Any combination of the parent, student, and teacher signatures 
may be required.
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